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Preface

Purpose

This guide describes how to install and configure Progress Dynamics® Version 2.1B. It also 
describes how to install and view the Progress Dynamics online documentation.

Audience

This guide is designed for Progress® 4GL programmers who have some familiarity with 
Progress ProVisionPlus®, the ADM, and WebSpeed® (for creating Web applications).

Organization

This guide is organized as follows:

Chapter 1, “Before You Install Progress Dynamics”

Describes what you need to do before you install Progress Dynamics software on your 
system. It includes a checklist of installation tasks depending on whether you are installing 
Progress Dynamics for the first time or upgrading from the previous Progress Dynamics 
release.

Chapter 2, “Installing Progress Dynamics”

Describes how to run the installation programs for the Progress Dynamics Version 2.1B 

software. The installation of Progress Dynamics consists of two parts: an InstallShield® 
executable and a Progress 4GL utility, the Progress Dynamics Configuration Utility.
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Chapter 3, “After You Install Progress Dynamics”

Describes how to set up and start your Progress Dynamics framework to develop and run 
applications. 

Appendix A, “Installing and Viewing Progress Dynamics Documentation”

Describes how to install and view the online Progress Dynamics documentation. 

Typographical conventions

This manual uses the following typographical conventions:

• Bold typeface indicates:

– Commands or characters that the user types

– That a word carries particular weight or emphasis

– Names of user interface elements

• Italic typeface indicates:

– Progress variable information that the user supplies

– New terms

– Titles of complete publications

• Monospaced typeface indicates:

– Code examples

– System output

– Operating system filenames and pathnames
viii
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The following typographical conventions are used to represent keystrokes:

• Small capitals are used for Progress key functions and generic keyboard keys.

END–ERROR, GET, GO
ALT, CTRL, SPACEBAR, TAB

• When you have to press a combination of keys, they are joined by a dash. You press and 
hold down the first key, then press the second key.

CTRL–X

• When you have to press and release one key, then press another key, the key names are 
separated with a space.

ESCAPE H
ESCAPE CURSOR–LEFT

Progress messages 

Progress displays several types of messages to inform you of routine and unusual occurrences:

• Execution messages inform you of errors encountered while Progress is running a 
procedure (for example, if Progress cannot find a record with a specified index field 
value).

• Compile messages inform you of errors found while Progress is reading and analyzing a 
procedure prior to running it (for example, if a procedure references a table name that is 
not defined in the database).

• Startup messages inform you of unusual conditions detected while Progress is getting 
ready to execute (for example, if you entered an invalid startup parameter).

After displaying a message, Progress proceeds in one of several ways:

• Continues execution, subject to the error-processing actions that you specify, or that are 
assumed, as part of the procedure. This is the most common action taken following 
execution messages.

• Returns to the Progress Procedure Editor so that you can correct an error in a procedure. 
This is the usual action taken following compiler messages.
ix
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• Halts processing of a procedure and returns immediately to the Procedure Editor. This 
does not happen often.

• Terminates the current session.

Progress messages end with a message number in parentheses. In this example, the message 
number is 200:

Use Progress online help to get more information about Progress messages. Many Progress 
tools include the following Help menu options to provide information about messages:

• Choose Help→ Recent Messages to display detailed descriptions of the most recent 
Progress message and all other messages returned in the current session.

• Choose Help→ Messages, then enter the message number to display a description of any 
Progress message. (If you encounter an error that terminates Progress, make a note of the 
message number before restarting.)

• In the Procedure Editor, press the HELP key (F2 or CTRL–W).

** Unknown table name table. (200)
x



1
Before You Install Progress Dynamics

This chapter provides information about what you need to do before you install Progress 
Dynamics® software on your system, as described in the following sections:

• Checklist of installation tasks

• System requirements

• Preinstallation tasks

• Preinstallation tasks for upgrades
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1.1 Checklist of installation tasks
This section summarizes the steps you need to follow depending on whether you are:

• Installing Progress Dynamics for the first time.

• Upgrading Progress Dynamics.

1.1.1 Installing Progress Dynamics for the first time
Here is a checklist that summarizes the tasks you must follow if you have not previously 
installed Progress Dynamics:

Before installing

Install the prerequisite software: 

• Progress® ProVision® Plus Version 9.1D or 9.1E (with the latest patch).

• Internet Explorer Version 5.5 (or later) Web browser (Version 6.0 is recommended).

• A Web server.

NOTE: The Web browser and Web server are required only if you intend to develop 
browser-based applications. Progress Dynamics Web Development Guide has 
more information about these requirements.

Obtain a site ID and register your Progress Dynamics databases. For more information, see 
the “Registering your Progress Dynamics site and Repositories” section.

Read the hard copy release notes that come with the Progress Dynamics Installation 
CD-ROM.

Close any Windows programs that are running.
1–2
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Installing

Run the InstallShield Program. See the “Running the InstallShield program” section in 
Chapter 2, “Installing Progress Dynamics.”

Run the Dynamic Configuration Utility (starts automatically once the InstallShield 
program finishes). See the “Running the Progress Dynamics Configuration Utility” 
section in Chapter 2, “Installing Progress Dynamics.”

After installing

Edit your services file to point to the icfdb Repository and your application databases (for 
client networking). See the “Editing your Windows services file” section in Chapter 3, 
“After You Install Progress Dynamics.”

For Web development, test the Broker/Agent setup, Managers, and startup page. See 
Progress Dynamics Web Development Guide for more information. See the “Setting up 
for Web development” section in Chapter 3, “After You Install Progress Dynamics.”

Start Progress Dynamics initially as Admin (default login) so that the DCU can load the 
Repository data. See the “Starting Progress Dynamics” section in Chapter 3, “After You 
Install Progress Dynamics.”

1.1.2 Upgrading Progress Dynamics
The checklist that follows summarizes the tasks you must perform to upgrade from a previous 
version of Progress Dynamics to Version 2.1B. 

Follow these steps when you want to keep the previous version installed and configured on your 
machine until the entire upgrade and installation process is complete. Therefore, it is important 
to install Progress Dynamics to Version 2.1B in a new directory so the installation does not 
overwrite the files for the previous version.

You can install two versions of Progress Dynamics on the same machine if they are different 
version numbers. For example, you can have an instance of Version 2.1A and 2.1B installed on 
the same machine. You cannot install multiple instances of the same version on the same 
machine. For example, you cannot install multiple instances of 2.1B on a single machine. 
(However, you can have multiple repositories for the same version on the same machine.)

NOTE: The information in this section is for users who are upgrading from Progress 
Dynamics Version 2.0 or 2.1A to Version 2.1B. For information on upgrading from 
earlier versions, go to the following Web page: 
http://psdn.progress.com/library/progress_dynamics/index.ssp
1–3
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Before installing

Install the prerequisite software:

• Progress ProVision Plus Version 9.1D (with the latest patch).

• Internet Explorer Version 5.5 (or later) Web browser (Version 6.0 is recommended).

• A Web server.

NOTE: The Web browser and Web server are required only if you intend to develop 
browser-based applications.

Create a Progress Dynamics Version 2.1B working directory. See the “Set up the Version 
2.1 working environment” section.

Make a copy of the icfdb Repository database from the previous version and place it into 
the Progress Dynamics Version 2.1B working directory you just created. See the “Set up 
the Version 2.1 working environment” section.

Shut down all AppServers, WebSpeed Brokers, and other clients that are directly 
accessing the Progress Dynamics Repository.

Read the hard copy release notes that come with the Progress Dynamics Installation 
CD-ROM.

Close any Windows programs that are running.

Installing

Run the InstallShield Program. (Install Version 2.1 on the same machine that hosts the 
previous version of Progress Dynamics. However, you must install Version 2.1 in a 
directory different from the installation directory for the previous version of Progress 
Dynamics.) See the “Running the InstallShield program” section in Chapter 2, “Installing 
Progress Dynamics.”

Run the Dynamic Configuration Utility (starts automatically once the InstallShield 
program finishes). See the “Running the Progress Dynamics Configuration Utility” 
section in Chapter 2, “Installing Progress Dynamics.”
1–4
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After installing

Edit your services file to point to the icfdb Repository and the application databases for 
both versions of Progress Dynamics. You must do this if you are running servers for the 
databases. See the “Editing your Windows services file” section in Chapter 3, “After You 
Install Progress Dynamics.”

For Web development, test the Broker/Agent setup, Managers, and startup page. See 
Progress Dynamics Web Development Guide for more information.

If you customized the icfconfig.xml file in the prior version, you must edit this file so 
that you can start Progress Dynamics Version 2.1B. See the “Edit the Progress Dynamics 
XML configuration file” section in Chapter 3, “After You Install Progress Dynamics.”

Start Progress Dynamics initially with a client/server connection from a GUI client and 
login as Admin (default login) so that the DCU can load the Repository data. See the 
“Starting Progress Dynamics” section in Chapter 3, “After You Install Progress 
Dynamics.”

Recompile all of your application code. See the “Recompile application code” section in 
Chapter 3, “After You Install Progress Dynamics.”

1.2 System requirements
This section describes the system requirements for a Progress Dynamics Version 2.1B 
installation. System requirements include:

• Supported platforms

• Software prerequisites

1.2.1 Supported platforms
Progress Dynamics is a Windows-only release. The Progress Dynamics Installation CD-ROM 
lets you install all of the components on one Windows-based client machine, including a 
development AppServer for the Progress Dynamics Repository. If you prefer, you can choose 
not to install the Repository and AppServer on the client machine. Instead, you can set up the 
Repository and AppServer on a separate machine, configuring the client to reference them as 
needed.
1–5
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Progress Dynamics Version 2.1B runs on the following Windows platforms:

• Windows NT/Intel 4.0

• Windows 2000

• Windows XP

• Citrix Metaframe

• Windows 98

To install the Repository on a UNIX AppServer, you must have an existing Windows Progress 
Dynamics installation from which you can deploy the Repository and server code to the target 
AppServer environment. For more information on deploying the Repository and code, see the 
deployment chapter in Progress Dynamics Administration Guide.

1.2.2 Software prerequisites
Before you can install and configure Progress Dynamics on your system, you must have 
Progress ProVision Plus Version 9.1D installed with the latest Progress Version 9.1D patch 
level on the client and any AppServer machines. To identify and find more information on 
installing the latest patch level for Progress Version 9.1D in your machine environment, go to 
the Progress Patches Web page (http://www.progress.com/patches).

If you plan to develop Web applications with Progress Dynamics, you must have the following 
software installed on your machine:

• Internet Explorer Version 5.5 (or later) Web browser. (Internet Explorer Version 6.0 is 
recommended.)

• A Web server.

NOTE: If you use Roundtable™, see the information on the following Web site: 
http://psdn.progress.com/library/progress_dynamics/
1–6
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1.3 Preinstallation tasks
Before you install Progress Dynamics, you must:

• Read the hard copy release notes that come with the Progress Dynamics Installation 
CD-ROM. They might contain information that replaces or supplements the installation 
information in this chapter.

• If you plan to create a Dynamics ICFDB Repository database on a remote machine (that 
is, a machine other than the one on which you are running the Progress Dynamics install 
program), you first need to use the PRODB utility to create an empty database on the 
remote machine. For more information on the PRODB utility, see the Version 9.1D 
Progress Database Administration Guide and Reference.

• If you plan to develop applications for the Web with Progress Dynamics, you must start 
the Web server that you plan to use.

• Close any Windows programs you have running.

• If you are a new user, you must obtain a site ID and register your Progress Dynamics 
databases. For more information, see the “Registering your Progress Dynamics site and 
Repositories” section.

1.3.1 Registering your Progress Dynamics site and 
Repositories

The Dynamics Site Number Allocation application is a free service for allocating site numbers 
for your Progress Dynamics installation. Before installing and configuring Progress Dynamics 
on your system, go to http://www.progress.com/dynamics/sitenumber and do the 
following:

1. Register your Progress Dynamics site with a unique site code (that you define). A site 
code uniquely identifies a Progress Dynamics site. A site is a location where the Dynamics 
software is installed. There are two types of sites: development sites where you develop 
Dynamics applications, and end-user sites where you deploy Dynamics applications. A 
site is uniquely identified with a site code that you define. For example, the site code could 
be your company or organization code, or (if you are registering as an individual) your 
name.
1–7
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2. Register each Progress Dynamics Repository at your site with a unique site 
identification number. A site identification number uniquely identifies a Dynamics 
Repository. More importantly, it ensures the integrity of Dynamics Repository data among 
Dynamics sites and applications, worldwide, as well as between versions of Progress 
Dynamics. You need a site number for each Dynamics Repository at an individual site.

CAUTION: If you do not register a unique site number for each individual Progress 
Dynamics Repository at your site, deploying object data you created in that 
Repository could cause that data to become lost or corrupted.

You can allocate individual site numbers as you need them, or allocate a block of site 
numbers to keep in reserve. When allocating an individual site number, you can enter a 
specific site number or let the control automatically generate one for you. When allocating 
a block of site numbers, you can enter a starting site number value and the number of site 
numbers you want to allocate. You can also let the application automatically generate a 
starting site number value for you. If you specify a site number that already exists, the 
application will display a message.

1.4 Preinstallation tasks for upgrades
This section describes the tasks you must complete before beginning the process of upgrading 
a Progress Dynamics application to Version 2.1. The following sections describe the 
prerequisite tasks:

• Back up databases

• Set up the Version 2.1 working environment

NOTE: The recommended upgrade is from Progress Dynamics Version 2.0 or 2.1A to 
Version 2.1B. This manual does not include information on upgrading from Progress 
Dynamics Version 1.1A. For information on upgrading from earlier versions, go to: 
http://psdn.progress.com/library/progress_dynamics/

1.4.1 Back up databases
Before you do anything else, back up existing icfdb and application databases. Use the 
PROBKUP utility, which is described in Progress Database Administration Guide and 
Reference.
1–8
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1.4.2 Set up the Version 2.1 working environment
To set up the Version 2.1 working environment prior to the upgrade: 

1 ♦ Create a working directory for the icfdb database that you want to upgrade.

Typically, the working directory for the upgrade will be a folder under the Progress 
Dynamics Version 2.1 working directory. For example:

2 ♦ Copy the existing icfdb database to the working directory that you created in Step 1. 

You can use any of a number of database utilities, including the Data Dictionary, PROCOPY, 
PRODB, and PROREST. See Progress Database Administration Guide and Reference for 
more information.

3 ♦ Copy the initialization file from dynamics21b_install_dir/bin/icf.ini to the working 
directory that you created in Step 1. For example:

4 ♦ Edit the icf.ini file so that it is similar to the icf.ini file for the previous release.

Make sure that the PROPATH points to the working copy of your icfdb (that is, the icfdb 
that you want to upgrade) and not to your original or backup copies.

5 ♦ Create a working directory for your application database. For example:

C:\Dynamics21b\WRK\databases\icfdb\

C:\Dynamics21b\WRK\databases\icfdb\icf.ini

C:\Dynamics21b\WRK\databases\sports2000\
1–9
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6 ♦ Copy the application database to the directory you created in Step 5.

7 ♦ If you are upgrading from a previous version of Progress Dynamics, create a working copy 
of the application code from the previous version. Application code must be recompiled 
when you upgrade.

You should create a working copy of the source code (.p, .w, and .i files) relevant to your 
application. These files are usually stored in the product module folders that you created 
during application development. 

Do not copy compiled code (the .r files). They will not run under Version 2.1 and could 
be a source of confusion.
1–10



2
Installing Progress Dynamics

This chapter describes how to install and configure Progress Dynamics Version 2.1B and 
includes the following sections:

• Installation overview

• Running the InstallShield program

• Running the Progress Dynamics Configuration Utility
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2.1 Installation overview
The installation of Progress Dynamics is typically seamless from start to finish, but consists of 
two distinct parts:

1. An InstallShield® executable that:

• Creates and loads product directories with Dynamics code files (for the Tools, ADM, 
and Managers).

• Creates the Dynamics program folder with basic shortcuts.

• Adds all necessary registry entries to support this installation.

2. A Progress 4GL utility, the Progress Dynamics Configuration Utility (DCU) that executes 
immediately after the InstallShield process finishes, and:

• Tailors and upgrades the Dynamics Repository database in a new environment.

• Upgrades an existing Repository from one release to the next.

• Acts as a framework where you can create a process for upgrading and updating the 
databases that form part of your applications. (For more information on customizing 
and extending the DCU, see Progress Dynamics Administration Guide.)

2.2 Running the InstallShield program
To install Progress Dynamics, follow these steps:

1 ♦ Read the hard copy release notes, which provide important information on the current 
Progress Dynamics release.

2 ♦ Make sure you have met all the preinstallation requirements. For more information, see 
Chapter 1, “Before You Install Progress Dynamics.”
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3 ♦ Place the Progress Dynamics Installation CD into your CD-ROM drive. The Progress 
Dynamics Installation Program starts up, displays the Progress splash screen, and prepares 
to guide you through the rest of the installation, as shown:

The Installing Progress Dynamics window appears, followed by an alert box that 
reminds you to download the latest Progress Version 9.1D or 9.1E patch, as shown:

4 ♦ Choose OK. The installer displays a message that indicates it is checking your system 
requirements as it locates your existing Progress Version 9.1D or 9.1E installation, then 
displays the Welcome screen:
2–3
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5 ♦ Choose Next. The Serial & Control Numbers screen appears:

6 ♦ Enter the product Serial Number and Control Number on the license addendum that you 
received with your Progress Dynamics CD-ROM, then choose Accept. The Progress 
Dynamics product name appears in the Product(s) to be installed list, as shown:
2–4
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7 ♦ Choose Next. The Choose Destination And Working Path Directories screen appears:

CAUTION: Do not use the default directories if you are upgrading. If you used the default 
directories when you installed earlier versions of Progress Dynamics, this 
installation will overwrite the software, unless you specify different 
destination and working directories.You must preserve earlier installations in 
order to upgrade your applications.

8 ♦ If you are installing Progress Dynamics for the first time, accept the defaults or choose 
Browse to specify a different Destination Directory or Working Directory.

If you are upgrading from a previous release, choose Browse to specify a Destination 
Directory that is different from the one you used for the previous version of Progress 
Dynamics. For the Working Directory, specify the Version 2.1B working directory you 
created in Chapter 1, “Before You Install Progress Dynamics.” (This is the directory in 
which you placed a copy of your icfdb Repository database from a prior version of 
Progress Dynamics.)

CAUTION: Make sure that the Working Directory is different from, and not in the same 
path as, the Destination Directory.
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NOTES:

• The installer does not let you specify your Progress Version 9.1D or 9.1E installation 
directory as the Destination Directory for Progress Dynamics. Progress Dynamics 
and Progress Version 9.1 share some of the same filenames. If you installed Progress 
Dynamics into the same directory as Progress Version 9.1, you would overwrite the 
Version 9.1 files.

• The Working Directory is the default location where, if you chose to create the 
Dynamics Repository, the installer creates and loads the ICFDB database.

9 ♦ Choose Next. The installer displays the AppServer and WebSpeed Broker Options 
screen:

If you select them, the specified Progress Dynamics Options have the following effects 
when the InstallShield finishes its part of the installation:

• Create AppServer — The installer edits the following properties file to include a 
local AppServer named icfrepos:

Progress9.1D-Install-Dir\properties\ubroker.properties
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This AppServer supports the icfrepos application service, which accesses the 
Repository for development. If you do not want to use an AppServer for 
development, or if you want to set up the AppServer manually (for example, on a 
separate network machine), do not select the Create AppServer option.

CAUTION:You should use an AppServer for testing, especially if you plan to 
deploy the application to a Progress Dynamics environment that uses an 
AppServer. This ensures that you do not compile any schema validation 
into your user interface (UI) code that will fail to execute in a client 
session with no database connections.

• Create WebSpeed Broker — For developing Web applications with Progress 
Dynamics, the installer edits the following properties file to include a local 
WebSpeed broker named wsdynamics1:

This WebSpeed broker supports the wsdynamics1 application service, which 
accesses the Repository at run time. If you want to set up the WebSpeed broker 
manually (for example, on a separate network machine), do not select the Create 
WebSpeed Broker option. For more information about manually creating brokers, 
see Progress Dynamics Web Development Guide.

NOTE: The Installer creates a backup of your properties files before it makes any 
changes according to the options you select. You can view or modify these 
new definitions using Progress Explorer.

• Copy Static HTML Files To Document Root Directory — If you plan to develop 
Web applications with Progress Dynamics, specify if you want the static Dynamics 
Web files copied to your Web server’s document root directory. 

If you choose not to copy the static files to the document root directory, you must 
create a virtual directory on your Web server that points to the location of the static 
files. The static files physically reside in install-path\tty\icf\ry. See Progress 
Dynamics Web Development Guide for more information.

Progress9.1D-Install-Dir\properties\ubroker.properties
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10 ♦ After specifying the AppServer and WebSpeed Broker options you want, choose Next. 
The Select Program Folder screen appears:

11 ♦ After entering or verifying the name of the Program Folder for your Progress Dynamics 
installation, choose Next. The Summary screen appears. You can accept the final 
installation options or move back through the installation dialog boxes to change them:

p
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12 ♦ When you are ready to accept the listed options, choose Next. The installer displays a 
message about copying support files, then displays the Installing Files alert box while it 
continues with the installation, as shown:

You can stop the installation at any time before it reaches 100% by choosing Quit. This 
causes the installer to stop and exit to the operating system without completing the 
Progress Dynamics installation.

Once the Progress Dynamics file installation is complete, the installer displays the 
following information box until it finishes creating the Progress Dynamics Program folder 
and shortcuts:

The Complete Setup Done screen appears when the InstallShield part of the installation 
is complete.

13 ♦ Choose Finish to continue with the next part of the installation. The Progress Dynamics 
Configuration Utility (DCU), which is described in the next section, automatically runs 
when the installation completes. The DCU installs and configures any specified 
Repository databases and other Progress Dynamics services required for this installation.
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2.3 Running the Progress Dynamics Configuration Utility
To complete the Progress Dynamics installation, Progress provides the Dynamics 
Configuration Utility (DCU). The DCU is a Progress 4GL program. It completes the installation 
by building a new icfdb Repository database or by upgrading an existing one from a previous 
release.

NOTE: The DCU does not remove any part of a Progress Dynamics installation.

The DCU performs its work in a progressive and re-entrant fashion. If for any reason the DCU 
does not complete its work, or if you quit the utility before it has a chance to finish, you can 
rerun it (from the command line or a shortcut) to complete its work. 

Note that you can extend the DCU and use it to install your own applications in either GUI mode 
or batch mode. For more information about the DCU, see Progress Dynamics Administration 
Guide.

After you choose Finish in the InstallShield’s Complete Setup Done dialog box, a Progress 
session starts up with an information box indicating that it is parsing the XML file. Then, the 
DCU wizard starts by displaying the Progress Dynamics Configuration Utility—Welcome 
dialog box.

To complete the DCU wizard, follow these steps:

1 ♦ Choose Next, and the Install Path dialog box appears.

2 ♦ Enter the path of the directory where Progress Dynamics Version 2.1 is installed. The 
Install Path field contains a default entry based on the information you provided when 
you installed Progress Dynamics, as shown:
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3 ♦ Enter the path for the DCU log file. The Log File field contains a default pathname.

4 ♦ Choose Next and the Working Paths dialog box appears.

5 ♦ Enter the path information in the Working Path, Source Path and GUI Path fields. The 
fields contain default entries based on the information you provided when you installed 
Progress Dynamics, as shown:

NOTE: The Working Path must not be under your Progress installation directory or 
your Progress Dynamics installation directory. Otherwise, you can lose all of 
your work during future installs and upgrades of these products. (The current 
example assumes that Progress Version 9.1D is installed in a separate 
subdirectory, such as C:\Progress\V91d.)

6 ♦ After you enter the appropriate path information, choose Next. The ICFDB Parameters 
dialog box appears.
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7 ♦ Enter the path of your icfdb database and the database connection parameters.

The following figure shows connection parameters for single user mode, however, the 
DCU upgrade can also run with a network connection to the icfdb database:

NOTE: If you run the DCU with the –icfparam DCUSCRIPTFILE option, the DCU does 
not update the repository, but writes the repository information to the specified 
DCU script file (and site data file, if specified) for use by the batch mode DCU. 
For more information on the batch mode DCU, see Progress Dynamics 
Administration Guide.

For more information on connection parameters, see the Progress Version 9.1D or 9.1E 
Progress Startup Command and Parameter Reference.

If you try to use the Create New ICFDB Database option to create a database on a remote 
machine, you will get an error message. To load the icfdb schema to a remote database, 
you first need to create the database on the remote machine by starting a Progress Version 
9.1D or 9.1E client and running the PRODB utility. For more information on the PRODB 
utility, see the Version 9.1 Progress Database Administration Guide and Reference.

CAUTION: If you are upgrading, you should remove the check marks from the Create 
new ICFDB Database and the Load ICFDB Database schema options. 
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Also, note the following if you are upgrading:

a) If you check only the Create new ICFDB Database option, the DCU automatically 
loads the database schema as well. The DCU also deletes any database that already 
exists in the specified icfdb path and creates a new one.

b) If you check only the Load ICFDB Database schema option, the DCU treats any 
existing icfdb as if it was empty and loads the schema.

8 ♦ After you enter the appropriate information, choose Next. The ICFDB Patches dialog box 
appears if you are upgrading. If this is a new installation, the ICFDB Patches dialog box 
does not appear and you can go to Step 11.

9 ♦ Review the patch information.

The DCU lists the patches needed to upgrade your database to the latest level. The list will 
vary depending on what patch level was added to the previous version of your icfdb 
database. The DCU applies the necessary patches in the correct order, as shown:

10 ♦ Choose Next. The ICFDB Site Number dialog box appears.
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11 ♦ Enter appropriate values in the Site Number, Site Sequence 1, Site Sequence 2, and 
Session ID fields:

If this is a new installation:

• See the “Registering your Progress Dynamics site and Repositories” section in 
Chapter 1, “Before You Install Progress Dynamics,” for information about obtaining 
a site number.

• Accept the defaults for the other fields.

If you are upgrading, the DCU transfers sequence values from the previous version of the 
Repository, or you can obtain these values from the Set Site Number dialog box. You can 
access the Set Site Number dialog box from the Progress Dynamics AppBuilder Build 
menu. 

NOTE: Verify that the Site Sequence 1 value is incremented when you are upgrading. If 
the Site Sequence 1 value in this installation is less than the value in the previous 
release, you will get error messages stating that an Object ID is already used.
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12 ♦ After you enter the appropriate values, choose Next. The Processing Status dialog 
appears.

CAUTION: If you are upgrading, this is a good time to make a backup of your existing 
Progress Dynamics configuration. You might want to refer back to your prior 
configuration. The DCU processing that occurs next is irreversible. You will 
lose configuration information if you do not make a backup before running 
the DCU.

13 ♦ Choose Process to start the DCU.

As shown in the following figure, an informational dialog box appears that indicates which 
upgrade program is currently running:

14 ♦ Choose Finish when the DCU completes processing.

15 ♦ Go to Chapter 3, “After You Install Progress Dynamics.”

If you are upgrading your installation, be sure to review the information in the “Additional 
tasks for upgrades” section in Chapter 3, “After You Install Progress Dynamics.”
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3
After You Install Progress Dynamics

This chapter describes how to set up and start your Progress Dynamics framework to develop 
and run applications, as described in the following sections:

• Editing your Windows services file

• Editing installed files

• Additional tasks for upgrades

• Setting up for Web development

• Starting Progress Dynamics

• Securing the Progress Dynamics installation

• Shutting down Progress Dynamics

• Uninstalling Progress Dynamics
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3.1 Editing your Windows services file
If you connect to the Progress Dynamics Repository database over a network, you must follow 
these steps to edit your services file to specify the service name and a port number for the icfdb 
Repository database:

1 ♦ In a text editor, open your services file. By default, the services file is in the 
C:\WINNT\System32\drivers\etc\directory. (On Windows XP, the directory is 
C:\WINDOWS\System32\drivers\etc\.)

2 ♦ Assign port numbers, using the following format:

The service_name is the name you specify with the -S parameter when you start the 
database. The port_number is a unique four-digit number (one that is not already assigned 
to another service in the file). For example:

3 ♦ Add an additional line for each of your application databases, using a unique service name 
and a unique port number for each one.

4 ♦ Save and close the services file.

CAUTION: You cannot start two Repositories if both have the same service name (icfdb, for 
example). If you need to run more than one Repository database, each version 
must have a different service name and a different port number. 

service_name port_number/tcp

icfdb 8000/tcp
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3.2 Editing installed files
Table 3–1 lists the files installed by the Progress Dynamics installer program that you can edit 
to modify configuration settings, add databases, or change paths.

Table 3–1: Progress Dynamics files that you can edit

Filename Description Location

icfconfig.xml An XML file containing the 
instructions used by the 
Progress Dynamics 
Configuration File Manager 
to start up a specified 
Progress Dynamics session.

For more information, see 
Progress Dynamics 
Administration Guide.

install_dir\gui\icf

Default:
C:\Program Files\Dynamics\gui\icf

startdbs.bat Starts database servers for 
the Progress Dynamics 
Repository by invoking 
proserve.

install_dir\bin

Default:
C:\Program Files\Dynamics\bin

stopdbs.bat Stops database servers for 
the Progress Dynamics 
Repository by invoking 
proshut.

icf.ini The Progress Dynamics 
initialization file (the 
Progress Dynamics version 
of the progress.ini file).

icf.pf The Progress Dynamics 
AppBuilder startup 
parameter file.

install_dir\

Default:
C:\Program Files\Dynamics
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3.3 Additional tasks for upgrades
If you are upgrading from an earlier version of Progress Dynamics, there are several additional 
tasks that you need to perform. To ensure that your existing applications run under the newer 
release, review and complete the tasks described in the following sections:

• Edit the Progress Dynamics XML configuration file

• Start a development session

• Stop and restart Progress Dynamics

• Update session types

• Run the Entity Import tool

• Recompile application code

NOTE: For Repository upgrades where end-users want to save their custom Repository 
changes, Progress Dynamics provides the Site Data Dump and Load Utility, which 
end users must use before and after they run the DCU. For more information on this 
utility, see Progress Dynamics Administration Guide.

3.3.1 Edit the Progress Dynamics XML configuration file
The DCU upgrade process is not complete at this point. The DCU needs to run again to apply 
other upgrade procedures and to update data sets for the newly created icfdb. The DCU 
automatically runs again when you start an administrative session. But before you can login and 
start an administrative session, you must have an XML configuration file that is compatible with 
the newer version of Progress Dynamics. 

If you did not create a new icfconfig.xml file (or edit the default) for your application, you 
can skip this section. You can simply use the standard install_dir\gui\icf\icfconfig.xml 
file that ships with Progress Dynamics to access the upgraded Repository.

However, if you modified or changed the name of the default XML configuration file (for 
example, you might have a customized XML configuration file in your current directory), you 
must edit the XML configuration file to make it compatible with your upgraded application. For 
example, you must add service entries for the new managers and change the connection 
parameters for your icfdb database.

You should only edit the icfconfig.xml file for the session type that you use as your 
administrative session type. That allows you to connect to your Repository with administration 
privileges. Then you can use the Dynamics Administration tool’s Session menu options to 
modify your other session types and regenerate the icfconfig.xml file.
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To edit your icfconfig.xml file:

1 ♦ Create a backup copy of icfconfig.xml before you edit it.

CAUTION: If you make a mistake in the following steps, you might render your 
icfconfig.xml file unreadable and your Dynamics session might not start. 
Therefore, creating a backup copy that you can revert to is extremely 
important.

2 ♦ Open your icfconfig.xml file in a simple text editor, such as Notepad.

3 ♦ Search for the string: SessionType=ICFDev where ICFDev is the name of the session type 
that you use for administration tasks. This string should occur inside a session node as 
follows:

Immediately following the <session> node is a <properties> node. 

4 ♦ Scan down the file until you pass the end of the properties node, which is denoted by the 
end properties tag (</properties>). 

Immediately following the <properties> node is a <services> node. The services node 
contains the list of services that should be connected when the session starts. Among them 
is a <service> node for each of the databases and AppServers that are connected to this 
session. Each service node is contained within a start service <service> and end service 
</service> tag. 

5 ♦ Search for a <cServiceName> tag with the value rvdb. If it exists, remove the entire 
<service> node for the RVDB service type from the file. 

The rvdb database is used in Progress Dynamics Version 1.1A. It became obsolete at 
Version 2.0A. There should be no references to it in any of your configuration files.

<session SessionType=ICFDev>
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6 ♦ Scan down until you find the first end managers (</managers>) tag. 

7 ♦ Insert the following XML statements immediately before that line:

8 ♦ Scan down until you find a service node that contains a <cServiceName> tag with the value 
icfdb. 

 <manager>

<cManagerName>RIManager</cManagerName>

<cFileName>ry/app/ryrisrvrp.p</cFileName>

<cHandleName>RI</cHandleName>

<cSuperOf/>

</manager>

<manager>

<cManagerName>CustomizationManager</cManagerName>

<cFileName>ry/app/rycussrvrp.p</cFileName>

<cHandleName>NON</cHandleName>

<cSuperOf/>

</manager>

<manager>

<cManagerName>RepositoryDesignManager</cManagerName>

<cFileName>ry/app/rydessrvrp.p</cFileName>

<cHandleName>NON</cHandleName>

<cSuperOf/>

</manager>
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9 ♦ Change the database connection parameters from the values for the earlier version to the 
appropriate values for the newer version.

The arguments for the -db and the -S parameters should be the icfdb that you upgraded 
through the DCU. The bold text in the following code shows the changes to the icfdb 
services entry:

NOTE: Since the upgrade simultaneously opens a large number of records, it is possible 
that you might get an error stating that the record lock table is too small. In that 
case, you must set the Lock Table Entries parameter (-L) to a very large value. 
(A value of 500,000 should be adequate.) See Progress Startup Command and 
Parameter Reference for more information.

10 ♦ Save the edited icfconfig.xml file.

11 ♦ Place the icfconfig.xml file in a directory that is included in your Version 9.1D PROPATH.

<service>
<cServiceType>Database</cServiceType>
<cServiceName>ICFDB</cServiceName>
<cPhysicalService>ICFDBn</cPhysicalService>
<cConnectParams>-db icfdbV21B -N TCP -H localhost 
-S icfdbV21B</cConnectParams>
<lDefaultService></cConnectParams>
<lCanRunLocal></lCanRunLocal>
<iStartOrder></iStartOrder>

</service>
3–7



Progress Dynamics Installation Guide
3.3.2 Start a development session
The DCU needs to run again to apply other upgrade procedures and to update data sets for the 
newly created icfdb. The DCU automatically runs again when you start a session that has 
administrative privileges. By default, you can run the development session (ICFdev) with 
administrative privileges. When you ran the DCU the first time, it wrote information to the 
Repository, which it now uses to complete the upgrade.

To update data sets, Progress Dynamics applies Application Dynamic Object (ADO) files to the 
Repository. ADO files are XML documents that have a .ado filename extension.

After you complete the tasks described in the “Edit the Progress Dynamics XML configuration 
file” section, you should be able to start a session that connects to the icfdb that the DCU 
upgraded.

To start an administrative session, follow these steps:

1 ♦ Start the DB servers for the newer version of Progress Dynamics, if they are not already 
running.

2 ♦ Start an administrative session, logging in as admin.

If you start a Progress Dynamics Development session from a desktop shortcut, check the 
properties to make sure that the value of ICFSESSTYPE is set to your administrative session 
type (usually ICFDev). Also, verify that the -ini and -pf parameters point to the Version 
2.1B initialization and startup parameter files. For example:

After you log in, the DCU starts, runs upgrade programs, and applies ADOs. The DCU displays 
a status window that indicates its progress. 

This phase of the upgrade involves running a large number of procedures that can be very time 
consuming. The actual duration depends on the size and complexity of your application. 

3.3.3 Stop and restart Progress Dynamics
After the DCU loads all of the ADOs, you will be in a Dynamics AppBuilder session. Before 
you can continue, you must apply the changes you made up to this point by stopping and 
restarting Progress Dynamics. Log out of the current session. When you log in again, you must 
start an administrative session, as described in the “Start a development session” section.

C:\Program Files\Progress91D\bin\prowin32.exe -p icfstart.p 
-pf "C:\Program Files\Dynamics21B\icf.pf" 
-ini "C:\Program Files\Dynamics21B\bin\icf.ini" 
-icfparam ICFSESSTYPE=ICFDev
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3.3.4 Update session types
In the “Edit the Progress Dynamics XML configuration file” section, you updated the session 
that you use to administer your Repository. Now, you must update any other session types that 
apply to your application.

NOTE: If you did not create a new icfconfig.xml file (or edit the default) for your 
application, you can skip this section. You can simply use the standard 
icfconfig.xml file that ships with Progress Dynamics to access the upgraded 
Repository.

From the Dynamics Administration Tool Session menu, access the Session Type Control and 
modify your existing session types. After modifying your session types, regenerate the XML 
configuration file. (You can also edit the configuration file manually, but manual editing is more 
error prone.) See Progress Dynamics Administration Guide for more information about 
defining, modifying, and managing sessions.

Modify your other session types as follows:

1. Remove the RVDB service from all session types that have it. It became obsolete at 
Version 2.0A. There should be no references to it in any of your session types.

2. Add the Reference Integrity Manager (RIManager) to all session types that make 
database connections. The manager’s filename is ry/app/ryrisrvrp.p.

3. Add the CustomizationManager to all session types that make use of the customization 
facilities and all development session types and server side (AppServer and WebSpeed) 
session types. The server side manager is ry/app/rycussrvrp.p, and the client side 
manager is ry/app/rycusclntp.p.

4. Add the RepositoryDesignManager to all development session types that construct 
objects and modify them using the AppBuilder toolset. The manager’s filename is 
ry/app/rydessrvrp.p.

The Repository Design Manager is only needed for development session types. It is not 
needed and should not be included in deployment sessions. It will only add unnecessary 
overhead when the application runs.
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If you plan to deploy your application as a browser-based application on the Web, you must 
create an ICFWS session type. (See Progress Dynamics Administration Guide and Progress 
Dynamics Web Development Guide for more information.) The ICFWS session type must 
include the following managers:

1. The RequestManager (ry/app/ryreqsrvrp.p) handles requests coming in from a Web 
browser. 

2. The UserInterfaceManager (ry/app/ryuimsrvrp.p) handles the interactions with the 
user interface.

The following example shows entries for all the new Version 2.x managers as they appear in the 
XML configuration file:

<manager>
<cManagerName>RIManager</cManagerName>
<cFileName>ry/app/ryrisrvrp.p</cFileName>
<cHandleName>RI</cHandleName>
<cSuperOf/>

</manager>
<manager>

<cManagerName>CustomizationManager</cManagerName>
<cFileName>ry/app/rycussrvrp.p</cFileName>
<cHandleName>NON</cHandleName>
<cSuperOf/>

</manager>
<manager>

<cManagerName>RepositoryDesignManager</cManagerName>
<cFileName>ry/app/rydessrvrp.p</cFileName>
<cHandleName>NON</cHandleName>
<cSuperOf/>

</manager>
<manager>

<cManagerName>RequestManager</cManagerName>
<cFileName>ry/app/ryreqsrvrp.p</cFileName>
<cHandleName>NON</cHandleName>
<cSuperOf/>

</manager>
<manager>

<cManagerName>UserInterfaceManager</cManagerName>
<cFileName>ry/app/ryuimsrvrp.p</cFileName>
<cHandleName>NON</cHandleName>
<cSuperOf/>

</manager>
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3.3.5 Run the Entity Import tool
When the DCU runs after the initial installation, it displays an important note indicating that you 
must run the Entity Import tool with Override all attributes from schema selected. Your 
upgraded application database might not run correctly if you do not run the Entity Import tool. 

Start the Entity Import tool from the main menu of the Administration Tool. Select System→ 
Entity Import.

In later versions of Progress Dynamics, DataFields are used extensively throughout the tools 
and at run time in Progress SmartDataObjects™ for attributes such as formats, data types, and 
labels. DataFields are a level of abstraction from the physical data storage. When you upgrade, 
you must run the Entity Import tool to ensure that Progress SmartObjects™ are created for every 
entity, with DataField instances representing the fields that belong to the entity.

In addition, due to the increased and fundamental use of DataFields, it is imperative that you 
keep them up-to-date. Whenever you make schema changes to your application database, you 
must use the Entity Import tool to update your application’s entities and DataFields. You must 
run the Entity Import tool against the central database for your organization. (If individual 
developers run the Entity Import tool on their own “satellite” databases, they might generate 
different Object IDs for the same DataField.)

By default, the Entity Import process does not overwrite any local changes you have made to 
attributes, such as labels, but if the value of your label matches the value of the old schema label, 
the Entity Import process updates the DataFields appropriately. The Entity Import tool includes 
an Override all attributes from schema toggle box. If you select this option, the Entity Import 
process overwrites the local changes you made to the values of the entity attributes with the 
schema values.

If you do not update the DataFields, then at run time the SDOs use the old values in the 
DataFields, thereby regressing your schema changes at run time.

NOTE: The generateDataFields API in the Repository Design Manager supports the 
overriding of local attribute values with database metaschema values for certain 
attributes, such as Format, Label, and Help.

3.3.6 Recompile application code
Any static application code (in product modules, for example) must be recompiled in Version 
2.1B. In particular, Version 1.1A code will not run in a Version 2.1B environment. However, 
you should recompile the application code from any previous release.
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3.4 Setting up for Web development
If you plan to use Progress Dynamics to create applications for the Web, you should:

• Test the Broker/Agent Setup.

• Test the Managers.

• Test the StartUp Page.

For detailed information about setting up and creating Web applications with Progress 
Dynamics, see Progress Dynamics Web Development Guide.

3.5 Starting Progress Dynamics
To start Progress Dynamics, follow these steps:

1 ♦ Open the Progress Dynamics program folder using one of the following methods:

• From the Windows Start menu, choose Programs→ Progress Dynamics to display 
the Progress Dynamics shortcuts in a menu.

• Open any shortcut that you have created to the Progress Dynamics program folder, 
which displays the Progress Dynamics shortcuts:
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Initially, these shortcuts include:

• Config — For opening the progress.cfg configurations file.

• Dynamics Configuration Utility — For starting the Progress Dynamics 
Configuration Utility.

• Dynamics Development — For application development while accessing the 
Repository directly, without using the Repository AppServer.

• Dynamics Runtime — For running an application while accessing the Repository 
directly, without using the Repository AppServer.

• Dynamics Runtime with AppServer — For running an application while accessing 
the Repository indirectly through the Repository AppServer.

• Start Dynamics DB Servers — For starting the Progress Dynamics Repository 
database, icfdb.

• Stop Dynamics DB Servers — For stopping the Progress Dynamics Repository 
database, icfdb.

• Release Notes — For opening and viewing the Progress Dynamics Version 2.1B 
online release notes.

• Uninstall — For uninstalling the Progress Dynamics software. Be sure to stop the 
Dynamics database server before you select this option.

As you become familiar with Progress Dynamics maintenance, you can create similar 
shortcuts for other types of sessions. For more information about configuring Progress 
Dynamics sessions, see the chapter on defining and managing sessions in Progress 
Dynamics Administration Guide.

2 ♦ If the database servers required for your Progress Dynamics session are not already 
auto-started, use one of the following methods to start them:

• Open the Start Dynamics DB Servers shortcut in the program folder to start them.

• Open the database servers that you require by using the Progress Explorer.

3 ♦ If it is not already auto-started, open any AppServer that your Progress Dynamics session 
requires by using the Progress Explorer, or by using the Progress asbman command from 
the appropriate system command line.
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4 ♦ Choose the Dynamics Development shortcut.

CAUTION: For an upgrade especially, you must choose this shortcut, and not the “with 
AppServer” option. For the DCU to complete the upgrade process, you must 
log on initially with a client/server or host-based connection (that is, one that 
uses a direct connection to the Repository database).

The Powered by Progress Software splash screen appears followed by the Application 
Login dialog box that you can use to authenticate users:

Initially, Progress Dynamics has one Login Name defined, admin, with no password. The 
Login Name is not case sensitive. 

5 ♦ In the Login Name field, type Admin. 

NOTE: For an upgrade, you must initially log on as Admin for the DCU to complete the 
upgrade of the Repository. If you no longer have a user called Admin, you must 
log on as a user who is defined in the Progress Dynamics User Maintenance 
window with Development User and Maintain System Data options checked 
on.

You can also select a language and organization (Company), and you can set the date that 
you want Progress Dynamics (or any Progress Dynamics application you run) to maintain 
as the session date. The default values include:

• Language — English, with several other languages predefined in the list.

• Company — <None>, which defaults to Default Company, the only organization 
predefined at installation.

• Processing Date — Today’s date, as set for your computer, but that you can change 
for the session by typing into the field or selecting from a pop-up calendar (...).

NOTE: The Password button is disabled because you can change your password using 
the Progress Dynamics Re-Logon function only after you have successfully 
logged in.
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6 ♦ After you have entered your log on information, choose OK.

For an upgrade, the Dynamics Configuration Utility runs in the background. It briefly 
displays a status box of its progress as it loads in the Repository data. You cannot start any 
AppServers or WebSpeed Transaction agents against the Repository until the DCU 
completes this upgrade.

The Progress Dynamics AppBuilder opens displaying the AppBuilder main window, 
Palette, and PRO*Tools windows, as shown:

This appears very much like the ProVision AppBuilder with some additional controls. 
You can tell that this is the Progress Dynamics AppBuilder because it:

• Displays the Progress Dynamics window bar icon ( ).

• Initially displays with the PRO*Tools palette opened.

• Has a Build menu on the menu bar and an Open Object button ( ) on the toolbar.

• Shows the currently logged-in user and company in the status bar.

• Has a SmartTreeView object ( ) on the object Palette.
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7 ♦ To access Progress Dynamics management functions, choose Tools→ Administration 
from the AppBuilder menu bar. This opens the Progress Dynamics Administration tool, as 
shown:

8 ♦ If you are upgrading, recompile all your application code to complete the upgrade process. 

At this point you can set global run-time options and secure your installation by setting up user 
authentication. For more information, see the “Securing the Progress Dynamics installation.” 
section and the chapter on security in Progress Dynamics Administration Guide.

3.6 Securing the Progress Dynamics installation
You can secure your Progress Dynamics installation by changing the password on the default 
admin account. Follow these steps to change the password:

1 ♦ After opening a development session and logging into Progress Dynamics, choose File→ 
Re-Logon from the menu bar on the AppBuilder window, or on any Progress Dynamics 
ADE menu controller, such as the Progress Dynamics Administration window. The 
Application Login dialog box appears with the Password button enabled:

NOTE: Company initially displays <None> for the Re-Logon function until Login 
Name has a password. Next time you run the Re-Logon function for this user, the 
default login company appears when you enter the Password field.
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2 ♦ Choose Password. The Change User Password dialog box appears:

Enter the old password, then enter and confirm the new password, and choose OK. If the 
password entries are valid, the User Password Change alert box appears:

Otherwise, an error message box appears to explain what was wrong and how to change it.

3 ♦ Choose OK in the User Password Change alert box. The Application Login dialog box 
appears:

4 ♦ Now you can log on with a valid username and password, using the new password for the 
same Login Name, and choose OK to continue with the session.
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3.7 Shutting down Progress Dynamics
To shut down Progress Dynamics, follow these steps:

1 ♦ Close the Progress Dynamics AppBuilder. This shuts down all Progress Dynamics tools 
that you still have open on the Windows desktop.

2 ♦ Close any AppServer required only by the Progress Dynamics session using the Progress 
Explorer or using the Progress asbman.bat script from the appropriate system command 
line.

3 ♦ Shut down the WebSpeed agents (optional).

4 ♦ Select Programs→ Progress Dynamics→ Stop Dynamics DB Servers to only shut down 
the database servers required by your Progress Dynamics session, or shut down the 
database servers individually using the Progress Explorer.

3.8 Uninstalling Progress Dynamics
The Uninstall utility removes all the files created by the InstallShield program in the destination 
directory.

NOTE: If you edited any of the contents of any of these files, the InstallShield still deletes 
them. However, if you renamed any of the files, the Uninstall program might fail.

Since the InstallShield program does not create the Repository, the Uninstall utility does not 
remove the Repository database. (The Dynamics Configuration Utility creates the Repository. 
If you want to delete the Repository, you must do so manually.)

To uninstall Progress Dynamics, follow these steps:

1 ♦ Shut down any Progress Dynamics client sessions that are running.

2 ♦ Stop the Progress Dynamics Repository database servers, if they are running.

3 ♦ Stop any Repository AppServer that is running.

4 ♦ From the Windows Start menu, choose Programs→ Progress Dynamics→ Uninstall. The 
Remove Programs from Your Computer dialog box appears.

5 ♦ Choose OK when the uninstall successfully completes.
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Installing and Viewing Progress Dynamics 
Documentation

This appendix describes how to install and view the online Progress Dynamics Documentation 
CD and includes the following sections:

• Viewing the PDF files 

• Searching the PDF files

• Manually opening the PDF files

• Copying the PDF files to your machine

• Error when inserting the CD

NOTE: You can also view the documentation set in PDF and in dynamic HTML formats on 
the Progress Web site at http://www.progress.com/v9/documentation.
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A.1 Viewing the PDF files
The Progress Dynamics PDF Documentation CD contains PDF files of the Progress Dynamics 
documentation set. The PDF files are viewable with the Adobe Acrobat reader software.

To view the PDF files on the CD, follow these steps:

1 ♦ Download and install the latest Acrobat Reader with Search for your platform from the 
following URL: http://www.adobe.com/products/acrobat/readstep2.html

When you download the reader, be sure to select the Include option for searching PDF 
files and accessibility support check box. Selecting this option downloads the Search 
version of the reader, which lets you search across the entire Progress Dynamics 
documentation set.

2 ♦ If auto-run is enabled when you insert the CD into your CD-ROM drive, the Start.html 
file automatically appears. You can use the links on this page to access the PDF files. If 
auto-run is not enabled, manually open the Start.html file in your Web browser (for best 
results, use Internet Explorer).

A.2 Searching the PDF files
You can use the Search button in the Acrobat Reader to search across all Progress Dynamics 
PDF files. However, when you click on a link to a book from the Start.html file, the PDF file 
(by default) launches as a plugin to the Web browser. That is, the PDF file appears in the same 
window as the Web browser. When the Reader is launched as a plugin, the Search button is not 
available. To avoid this, you can configure the Acrobat Reader to launch in a separate window 
using the procedures documented below. Additionally, testing has shown that you should use 
Internet Explorer, not Netscape, for the Search to work properly when accessing the PDF files 
from the Start.html file.
A–2



Installing and Viewing Progress Dynamics Documentation
A.2.1 Configuring Acrobat Reader Version 5.0 to launch in a 
separate window

To configure Acrobat Reader Version 5.0 to launch in a separate window, follow these steps:

1 ♦ Close your Web browser.

2 ♦ Start Acrobat Reader.

3 ♦ Choose Edit→ Preferences. The Preferences dialog box appears.

4 ♦ In the left pane, select Options.

5 ♦ Uncheck the Display PDF in Browser check box, then choose OK.

6 ♦ Close Acrobat Reader.

7 ♦ Start Internet Explorer and open the Start.html file.  Click on a link to any manual. The 
Acrobat Reader launches in a separate window and the Search button appears on the 
Acrobat toolbar.

A.2.2 Configuring Acrobat Reader Version 4.05 to launch in a 
separate window

To configure Acrobat Reader 4.05 to launch in a separate window, follow these steps:

1 ♦ Close your Web browser.

2 ♦ Start Acrobat Reader.

3 ♦ Choose File→ Preferences→ General. The General Preferences dialog box appears.

4 ♦ Uncheck the Web Browser Integration check box, then choose OK.

5 ♦ Close Acrobat Reader.
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A.2.3 Using the Search button
To use the Search button, follow these steps:

1 ♦ Start Internet Explorer and open the Start.html file.  

2 ♦ Open a link to any manual. The File Download dialog box appears.

3 ♦ Select the Open this File From Current Location option.

4 ♦ Uncheck the Always Ask before Opening this Type of File check box.

5 ♦ Choose OK. The PDF file opens in a separate window.

6 ♦ Choose the Search button on the Acrobat Reader toolbar and enter your search criteria. 
For more information on using the Acrobat Search, choose Help→ Plugin Help→ Using 
Acrobat Search.

A.3 Manually opening the PDF files
If you do not want to set up Acrobat Reader to launch PDF files in a separate window, you can 
open the PDF files manually on the CD rather than using the Start.html file. The PDF files are 
located in the following directories:

• adr — Contains Progress Dynamics ADM2 API Reference.

• dag — Contains Progress Dynamics Administration Guide.

• ddg — Contains Progress Dynamics Developer’s Guide.

• dgs — Contains Getting Started With Progress Dynamics.

• dig — Contains Progress Dynamics Installation Guide.

• dmr — Contains Progress Dynamics Managers API Reference.

• dph — Contains Progress Dynamics Programming Handbook.

• drr — Contains Progress Dynamics Repository Reference.
A–4



Installing and Viewing Progress Dynamics Documentation
• dub — Contains Progress Dynamics Product Update Bulletin.

• dwg — Contains Progress Dynamics Web Development Guide.

• woe — Contains Welcome to Progress OpenEdge Studio.

A.4 Copying the PDF files to your machine
If you want to copy the PDF files to your machine, you must copy all files and directories on 
the CD, in the directory structures defined on the CD. This way, you will retain the ability to 
search and jump between the PDF files.

A.5 Error when inserting the CD
If you have auto-run enabled on your machine, you might receive the following error message 
when you insert the CD into your drive:

However, the Start.html file does appear. Just choose OK for the error message and continue.

Could not find the file ..\start.html file
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